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1▼ ▼ ▼ ▼
Getting Started
The Duralink™ Server Manager is a Java-based enhancement to the 
Duralink Port Aggregation program, providing easy-to-use 
monitoring and status control of network ports and interface cards 
(NICs). This program uses a web browser running over HP 
OpenView®as its interface to enable simple point-and-click 
navigation, for a real-time display of system operations and 
diagnostics. If the server has more than six Adaptec NICs installed, 
Duralink Server Manager can only display the first six on the Status 
Graphing screen.

System Requirements
■ Windows NT 4.0 or greater.

■ An installed version of HP OpenView 5.01 for Windows NT® 
with an installed version of SNMP agent (refer to OpenView 
manual for system requirements etc.).

■ A color display and video adapter capable of 256 or more 
colors.

■ A Web Server running on the OpenView Management 
Console. (Microsoft® Peer Web Service or Internet Information 
Service, or Netscape Enterprise Server)

■ A Web Browser (preferably Internet Explorer 3.02 or Netscape 
Navigator 3.02, Internet Explorer 4.0 and Netscape 
Communicator 4.x are not currently supported).

❒
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2▼ ▼ ▼ ▼
Installation & Configuration
This section covers procedures required to install and configure the 
Duralink Server Manager to operate from HP OpenView. The 
following steps must be performed to ensure correct installation. 

■ Installing the Server Manager.

■ Configuring the Web Server.

■ Configuring the Web Browser.

■ Setting up  the SNMP Server.

■ Setting up OpenView Remote Consoles.

Note: It is assumed that HP OpenView will be installed prior 
to the procedures in this chapter.
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Installing the Server Manager
Before installing or uninstalling the Duralink Server Manager, first 
stop all processes that may cause unnecessary CPU delays or hinder 
the installation. If you had previously installed the Duralink Server 
Manage, the Adaptec Discovery daemon and the SnmpServer are the 
only Server Manager background processes. To stop these processes, 
use the ovstop updateDb and the ovstop SnmpServer commands.

1 Insert the Adaptec Web Management diskette into the floppy 
drive.

2 Click on the Start bar and click Run.

3 Type a:\setup to run the setup disk for the Server Manager.

4 Follow the instruction provided in the setup routine.

Note: Setup will install the Adaptec Web Component 
in the same directory that OpenView was installed in. 
Do not change this target directory. It is usually 
<drive>:\OpenView. This path (drive and directory 
name) will be referred to as $OV in the subsequent 
text.

5 If the Network Node Manager (NNM) is running, exit from the 
application.

6 After setup is complete, ensure that the ovwdb daemon is 
running, then run the command: ovw -fields.

This command adds the isAdaptecDevice field into the 
OpenView database. 

Next, register the applications with the OpenView Process 
Management Daemon by running the following commands 
(these only need to be run when the Server Manager is first 
installed):

ovaddobj  $OV\lrf\AdptDiscovery.lrf

ovaddobj  $OV\lrf\SnmpServer.lrf

ovstart  updateDb

ovstart  SnmpServer
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7 If you choose to stop NNM services and then start them (via 
OpenView’s application menu), the ovstart commands covered 
in step 6 are not required.

The following components are installed:

■ Adaptec Discovery— This must reside in the $OV\bin 
directory. This application is automatically launched by 
OpenView, searches the OpenView database for Adaptec 
devices, and sets the database Object Properties accordingly.

■ SNMP Server— Application that provides the interface 
between the Java Applets(running on the browser) and the 
OpenView API. It must run on the OpenView Management 
Console.

■ Duralink Console— Application that places the Duralink icon 
and symbol on submaps depending upon the detection of the 
isAdaptecDevice field in the OV database.

■  Menu Registration files— The following registration files are 
installed in the $OV\lrf directory.

– AdptDiscovery.frf: Local Registration File required to start 
the application that searches the database for Adaptec 
Devices. Must reside in the  $OV\lrf  directory.

– AdptField.lrf: The field registration file used by OpenView 
to define the field isAdaptecDevice, indicating that a server 
has responded to the Adaptec OID and is manageable by 
DSM. This file must reside in the $OV\fields\C directory.

– MIB definition file (duralink.mib ): This file is installed in 
the $OV\AdaptecWeb directory.

– Trap configuration file (DTrap.conf ): Refer to Configuring 
OpenView to Receive Duralink Traps on page 2-9 of this 
manual for information on traps.

– SnmpServer.lrf: Local Registration File required to start the 
application that provides the interface between the Java 
Applets and the OV SNMP API. This must reside in the 
directory $OV\lrf directory.

– Duralink.srf: Symbol Registration File that defines the icon 
used for launching the Web Browser to manage Duralink 
Consoles. Must reside in the directory $OV\symbols\C.
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– DuralinkConsole.arf: Application Registration File that 
informs the OpenView process which application to launch 
when the Duralink Console icon is selected. This file must 
reside in the directory $OV\registration\C.

– AdptMgmtPage: Application Registration File that provides 
another mechanism to launch the web browser. The menu 
item will be enabled whenever a device that has the 
isAdaptecDevice field set is selected. This file must reside 
in the directory $OV\registration\C.

■  Java Applets (applets, web pages, and images)— These 
components are installed on the OpenView Management 
Console. They are downloaded by the web browser and will 
run on that machine. 

■ Hostname Server— Application that runs on remote Open 
View consoles. This application will retrieve the hostname that 
is selected by the local OpenView map. It is not necessary to 
install this component on the Management Console. It is done 
for convenience so that Remote Consoles can copy this file via 
a remote networked connection.

Configuring the Server to Send Traps

NT Server Configuration
1 From the Control Panel, select the Services icon.

2 From the Services list box, find the SNMP and SNMP Trap 
Service entries. The SNMP services must be started and set to 
Automatic. If they have not been started, click on each entry 
and select set them to Automatic. If the two services are not 
present, you must install them, refer to Loading Services on 
page 2-5.
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Loading Services
Follow these procedures if the SNMP Services entries are not present 
in the Services list box, as described above.

1 From the Control Panel, select the Network icon.

2 Click on the Services tab.

3 Click the Add Service button, and then click Have Disk.

4 Insert the Windows NT CD into the CD ROM drive and click 
OK.

5 From the Network Services dialog, select SNMP Service and 
then click Properties.

6 Type your community name in the Select Traps dialog box 
(default is Public).

7 To set a Trap Destination click Add, then type the IP address of 
the HP OpenView console in the dialog box. Click OK.

8 Restart the server to initialize changes.

NetWare Server Configuration
1 From the Server Console type: load edit.

2 From the NetWare text editor utility, press INS to browse 
directories.

3 Highlight volume.sys, and press Enter.

4 Select the etc directory and press Enter.

5 Select TRAPTARG.CFG and press Enter. Then, press Enter 
again.

6 If you are using an IPX-only address, enter the IPX number 
and MAC address of your server. For example, the numbers 
would be inserted as follows:

7 If you are using an IP Address type the IP Address of your 
OpenView console under Protocol UDP.

00000005:0000D11014E6

IPX Network Number MAC Address
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8 Save the above changes by pressing ESC. Press ESC again to 
exit the editor.

9 At the command prompt, type down, to down the server.

10 Type exit to return to the DOS prompt. Then, type server to 
restart the server.

Configuring the Web Server
To begin Web Server configuration you must stop and restart the 
Web Server. Do this by following the procedures described below for 
your web browser.

Note: The installation process will automatically update the 
registry if the Microsoft Web Servers are found.

Microsoft Web Server
1 Select the Internet Service Manager from the 

Start/Programs/Microsoft Peer Web service or Internet Information 
Service.

2 Single click on WWW Service .

3 Click on the Stop button, then on the Start button.

If  Duralink Server Manager was installed Prior to Installing the 
Microsoft Web Server:

1 Select the Internet Service Manager from the 
Start/Programs/Microsoft Peer Web service or Internet Information 
Service.

2 Double-click on WWW Service .

3 Select the Directories tab. Click the Add button.

4 Enter the directory path name ($OV\AdaptecWeb) in the 
directory field.

5 Type /AdaptecWeb in the virtual directory alias field.

6 Click the Execute field in the access box so that both Read and 
Execute are checked.
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Netscape Enterprise Server
1 Log in through the administrator's web site.

2 Select the name of the Web Server (next to the On/Off button).

3 Select View Server Settings from the left-hand menu.

4 Check the list to see that AdaptecWeb is not already configured.

5 Select Additional Document Directories from the Content 
Setting panel.

6 Enter $OV/AdaptecWeb in the Map to Directory field. Note that 
$OV is the path to the directory where OpenView is installed - 
usually it is c:\OpenView.

7 Enter /AdaptecWeb in the URL field. Click OK.

8 Click Save and Apply to save the server settings.
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Configuring the Web Browser
If you have not already done so, install a Web Browser on your OV 
Management Server machine. We recommend using Microsoft 
Internet Explorer 3.02  or Netscape Navigator 3.02.

If you use a proxy server to access the Internet, you will need to 
configure your browser to bypass the proxy server for the host that 
is running the OV Management Console. 

Microsoft Internet Explorer
1 Select View->Options from the toolbar. A pop-up window 

appears. 

2 Click the Connection tab. 

3 In the Exceptions box, enter the hostname (including any DNS 
suffix) in the entry box. 

Note: If the domain where this host resides is already 
present in the Exeptions box, no additional changes 
are required.

4 Select OK and then Exit.

Netscape Navigator
1 Select Options->Network Preferences from the toolbar. A 

pop-up window will come up. 

2 Select the Proxies tab by enabling the Manual Proxy 
Configuration radio button. 

3 Click View. 

4 Enter your hostname in the box labeled No Proxy for.
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SNMP Server Startup
This application is started by the OpenView Process Management 
Daemon. Typically, there is no need to manually start the SNMP 
server. However, in the unlikely event that the server is not running, 
you can perform the following steps: 

1 On the Open View Management console, open an MS-Dos 
window.

2 Run "SnmpServer" to start the server.

OpenView Remote Console Setup

Note: If there are no OpenView Remote Consoles in your 
environment, the following steps are not necessary.

1 Open an MS-Dos window, change to the directory where the 
Hostname Server is installed ($OV\AdaptecWeb\Remote 
Server).

2 Run "HostNameServer" to start the server.

Configuring OpenView to Receive Duralink 
Traps

1 Change directory to $OV\AdaptecWeb.

2 Run the following command:

xnmevents -replace DTrap.conf

The default action that is defined in this file will provide a 
popup window whenever a Duralink trap is sent by the 
managed node to the OpenView console. You can modify this 
actions from the Options\Event Configuration menu on the 
OpenView tool bar.

❒
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3▼ ▼ ▼ ▼
Running Duralink Server 
Software
This chapter describes how to load and operate the Duralink Server 
Software from within the OpenView Console.

Duralink Server Software provides access to activities and setup 
parameters for all installed Adaptec NICs through a Web browser. 
Activities and system status are viewed in real time through Java 
applets on the html-based screens.

Note: Consult the HP OpenView documentation when 
encountering problems with the OpenView console or when 
using any of the OpenView tools (such as ovw, ovaddobj, 
ovstart, etc).
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Loading the Program
1 Load the OpenView Network Node Manager by clicking on 

the Network Node Manager icon from the Programs menu.

The Openview Network Node Manager is loaded, showing all 
connections to the server. Refer to Figure 3-1.

Figure 3-1. OpenView Network Node Manager
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Enabling Adaptec NICs
1 From the Edit menu,  select Find then Object By Attribute.

Figure 3-2. Selecting an Object by Attribute

2 Scroll down the Object Attributes list box, highlight 
isAdaptecDevice then click Apply.
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3 A list of devices containing Adaptec NICs are displayed in the 
Located and Highlighted list box at the bottom portion of the 
screen. Highlight the server you wish to view and click Open. 
It is important to note that only one server can be selected and 
viewed at a time.

Figure 3-3. Selecting a Device with Adaptec NICs Installed

A map showing the selected device and its connect location is 
displayed. 

Figure 3-4. Segment Map
3-4



Running Duralink Server Software
4 Double-click on the server you wish to view. The map will 
expand to display the Duralink Console icon for the selected 
server.

Figure 3-5. Selected Server to View

Note: If the error message failed: OvwInitSession. Permission 
Denied  appears in the applet browser window when 
launching the Duralink Server manager, it indicates the 
SnmpServer was not started properly. Ensure that the 
$OV\conf\ovw.auth file contains the following line: 
hostname + [where hostname is the name of the Openview 
Management Server].

5 Double-click on the Duralink Server icon to load the Duralink 
Server manager program.
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Running the Duralink Server Manager
1 When the Duralink Console is selected, your web browser is 

loaded automatically and the Duralink main page is displayed.

Figure 3-6. Main Program Screen

2 To run the program, click on Proceed.
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Viewing Port Data
The Duralink Server Manager provides port data from the installed 
NICs on the selected device. Each NIC Is displayed graphically in 
the upper portion of the screen. Ports are displayed as open or 
closed. A closed, or inoperable port is shown with a red X.

Figure 3-7. Two Adaptec NICs Shown Graphically

Polling Interval

This page is updated every 10 seconds, meaning that an SNMP 
request is made to the device at that time. If a status change occurs 
during that time, the card image and port status table is updated 
dynamically. 

Note: The polling described above may increase the amount 
of network traffic on the segment due to increased SNMP 
traffic. To minimize the traffic on your segment, you can 
change the poll interval by editing the NetManage.html file. 
This file is located in the $OV/AdaptecWeb/Applets 
directory. Set the variable pollinterval to an adjusted value 
(defalt is 10,000 milliseconds, or 10 seconds). Initialize the 
change by selecting Reload.
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Port Status Table

At the bottom portion of the screen the adapter name, port status, 
group name, line speed, and the IP address(es) are provided in a 
table. Refer to figure below.

Figure 3-8. Port Status Table

■ Adapter Name— Refers to the installed adapter ports.

■ Port Status— Displays the operation status of each available 
port (Up, Down, or Standby).

■ Group Name— This column shows the user-assigned group 
name for the grouped ports when using Duralink Port 
Aggregation. When a stand-alone port is selected, this column 
will not display any name.

■ Line Speed—Shows the line speed in Mbps (10 or 100).

■ IP Address— Displays the assigned IP Address for each port. 
Grouped ports will carry the same IP address.
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Graph Display

You can view graphs of port status performance on a port 
aggregation group or interface, by clicking on any part of the status 
line in the Port Status Table. A graph is displayed for each NIC that 
is assigned to the group in the upper portion of the screen. In the 
lower portion is a graph that displays combined data of all ports that 
is assigned to the group or interface. 

Figure 3-9. Viewing Port Status

A Java-based Graph Controls dialog box appears in the upper 
portion of the screen. Maximize the box to display the options.

Individual Ports

Ports Combined
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From the Graph Controls dialog box you can set the interval and 
select the data to be displayed.

■ Set the Interval by typing in a time interval in seconds, in the 
data field. Click Change.

■ Select the data type to be displayed by clicking on the list box 
arrow.

A list of data types is displayed.

To set the graph controls, click on the list box to display the options. 
Any of the items in the list can be selected and displayed in the 
graph.

Duralink Specifics
The Duralink Server Manager port data table and graph are 
displayed differently for Duralink Port Aggregation groups than for 
stand-alone ports. This is because Port Aggregation typically 
handles more than one port in a single group with a single IP 
address. Where only one stand-alone port is ever displayed at one 
time. For more complete information on the Duralink programs 
refer to the Duralink Port Aggregation User’s Guide.
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Duralink Port Aggregation
Duralink Port Aggregation allows you to assign multiple ports to a 
group, using a single IP address, and balance the resources of all 
ports in the group for enhanced performance. Through the Duralink 
Server Manager, the specific group names are displayed and the 
shared IP address shown. As shown in Figure 3-10, each port is 
associated with the group it is assigned to, and will carry the group 
IP address.

Figure 3-10. Server With Duralink Port Aggregation Status Table

The graphing portion of the program shows each port of the selected 
group individually in the upper portion of the screen, as well as a 
graph of the aggregated group in the lower portion of the screen.

Figure 3-11. Duralink Port Aggregation Status Graphing
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Stand-Alone Ports
From within OpenView, only one stand-alone port at a time can be 
selected. Therefore, only a single stand-alone port can be displayed 
at a time through the Duralink Server manager.

Figure 3-12. Stand-Alone Port Display

❒
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